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1 Purpose of this document

The intention of this document is to provide definitions, information, and instructions about
immunisations and how they operate within Communicare.

This document also provides information about how immunisations interact with third-party vendors,
including:

e Service Australia — PKI Certificates
e Services Australia — The Australian Immunisation Register (AIR)
¢ National and state reporting requirements — nKPI, NT AHKPI and NSW KPI.

Intended audience of this document:

Communicare Administrators, Support Service Desk, Implementation Consultants, Practice
Managers, Immunisation Coordinators, end users.

2 Key Concept: What is the Australian Immunisation
Register?

The Australian Immunisation Register (AIR) is a national register that has the ability to record all
vaccines given to people of all ages in Australia.

The AIR enables a single electronic record for each person in Australia and shows what
immunisations they have received during their lifetime, given under specific programs.

The AIR includes vaccines given:

e Under the National Immunisation Program
e Through school programs
e Privately, such as for flu or travel

The AIR only accepts immunisation information from a recognised vaccination providers in Australia.
This includes Doctors, such as a General Practitioner, Community Health Centre, Child Health
Nurses, Aboriginal Health Workers, and Pharmacists.

So long as all the Provider numbers, Communicare settings and qualifying data requirements have
been met, an immunisation recorded as a clinical item in Communicare will be automatically
transmitted from Communicare to the Australian Immunisation Register and recorded in the individual
patient’s national AIR record.

For more information and to access national educational resources visit the Services Australia
website:

https://www.servicesaustralia.gov.au/organisations/health-professionals/subjects/air-education-
vaccination-providers
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3 Key Concept: nKPI, NT AHKPI and NSW KPI
reporting requirements

A number of vaccination programs in Australia require mandatory recording of vaccinations in the
AIR. In addition, depending on the activity in your health service, you may have more specific
reporting requirements such as associated with the following:

o National Key Performance Indicators for Aboriginal and Torres Strait Islander Primary Health
Care (nKPI)

e Northern Territory Aboriginal Health Key Performance Indicators (AHKPI)

¢ New South Wales Key Performance Indicators (NSW KPI)

e COVID 19 Vaccination Programs (commenced 2021)

For further information see 5.6.2 Immunisation Aged Based Reviews and 5.9 Immunisation Influenzas
vaccines
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4 Requirements for the AIR and nKPI, NT AHKPI or

NSW KPI reporting

Elements:

Required

Not Required

Data elements
required for
nKPI, NT AHKPI
or NSW KPI
reporting

Data elements for a
successful
transmission of an
immunisation
notification recorded
in Communicare to
the AIR.

Valid PKI Certificate
Provider Number (location or individual)
AIR Export code recorded in the clinical item configuration
Services.ini configured
Firewall Exceptions opened
Biographics - Patient name: Alphas, hyphens, apostrophes,
numeric and spaces only. If a hyphen is used, then no

space between the hyphen and the characters on both

sides of the hyphen

Biographics - Address: No Po Box number or ‘c/-" in line 1
or 2 of the address field.

Biographics — Address: Alphas, hyphens, apostrophes,
numeric and spaces only. If a hyphen is used, then no

space between the hyphen and the characters on both

sides of the hyphen

Biographics: A locality with a postcode number recorded in
the patients biographic

Biographics: A valid Medicare number
Biographics — Individual Health Identifier
Qualifier: ‘Dose this Course’ and/or ‘Dose Number’
Qualifier: Route and Site
Qualifier: Tick on, ‘Performed at this encounter place’
Qualifier: Vaccine batch (QLD)
Qualifier: Vaccine batch (All other states and territories)
Qualifier: Vaccine expiry date
Clinical ltem: No outstanding aged based Immunisation
review in the Communicare To Do list.

Review Immunisation; [birth/2 months/4 month/6month/12

month/18month/4year]

Clinical Iltem: Immunisations;<influenzas brand type>
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) Configuration of Communicare for Immunisations

To configure Communicare to record and transmit immunisation notifications to the AIR the following
elements will be required.

51 PKI Site Certificate

A valid PKI Certificate is required to transmit immunisation notifications to the AIR. The PKI Site
Certificate enables your organisation to:

e Transmit Medicare claims and check Medicare card validity
o Validate Healthcare Identifiers
e Transmit immunisations to AIR

For more information and to register for a PKI Site Certificate, refer to the Third Party Certificates and
Registration Requirements document and visit the Services Australia website,
https://www.servicesaustralia.gov.au/organisations/health%20-
professionals/services/medicare/public-key-infrastructure.

( HEALTH

Document
Third Party Certificates and Registration X
Requirement document Third Party Certificates and Registration Requirements docume
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5.2 Firewall Exceptions

A firewall is a network security device that monitors incoming and outgoing network traffic and
decides whether to allow or block specific traffic based on a defined set of security rules.

Firewalls establish a barrier between secured and controlled internal networks that can be trusted and
untrusted outside networks, such as the Internet.
A firewall can be hardware, software, or both.

The following addresses and ports must be open in your operating environment to transmit
immunisation notifications to the AIR:

Communication from the client machine

Medicare mcoe.humanservices.gov.au
Australia Online TCP Client 80

Claiming

Australian
Immunisation TCP Client www1.medicareaustralia.gov.au 443
Register

Communication from the server

Medicare mcoe.humanservices.gov.au
Australia Online TCP Server 80

Claiming

Australian
Immunisation TCP Server  www1.medicareaustralia.gov.au 443
Register

53 Services.ini file

The services.ini file contains a command line which executes the sending of immunisation
notifications to the AIR. Each site has the option to determine the time of day and the frequency at
which Communicare will transmit immunisation notifications the AIR.

AIR transmissions are sent at the interval and time configured in CCareQueue_RunAlIR.cmd. By
default, CCareQueue_RunAlR.cmd occurs at 2am daily. However, the services.ini can be configured
to send immunisation notifications any day of the week at any time of the day to the AIR.

AIR claims are processed overnight to allow sites to add/correct any information in the clinical item or
patient biographics before the notification of immunisation is submitted to the AIR.
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For immunisations that have not yet been transmitted to the AIR that require changes or deletion see
7.4 editing or deleting and immunisation recorded not yet transmitted to the AIR.

For immunisations that have been successfully submitted to the AIR that requires changes or
deletions see 7.5 Editing or deleting an immunisation record incorrectly or in error that has been
successfully transmitted to the AIR.

54 AIR Provider Number

Communicare transmits immunisation notifications to the AIR based on a provider number.
Two types of provider numbers that are issued by Services Australia are:

1. Anindividual (person + encounter place) provider number

o Anindividual provider number is associated with a person and the encounter
place that the person is providing service from.

o The individual provider number is what identifies the individual practitioner’s full
name and the practice address (locations/encounter place) from which they are
providing a service.

o An individual provider number is a requirement to be able to submit Medicare
Claims.

2. Alocation (encounter place) provider number

o Alocation provider number is associated with the physical building from which
immunisation notifications are transmitted to the AIR.

o This provider number is valid for the life of the building and is required (as of
2021) by Services Australia to transmit immunisation notifications to the AIR.

o The location (encounter place) provider number cannot be used to submit
Medicare Claims, it is only used to transmit immunisation notifications to the AIR.

If your organisation is intending to transmit immunisation notifications to the AIR and your
organisation does not have a location (encounter place) provider number then apply by contacting
Services Australia,

https://www.servicesaustralia.gov.au/organisations/health-professionals/services/medicare/australian-
immunisation-register-health-professionals/register/register-vaccination-provider

Note: It used to be that a location (encounter place) provider number was not a requirement to submit
immunisation notifications to the AIR and that an individual (person + encounter place) provider
number was sufficient, however as of the year 2021 Services Australia has revised their requirements
and now organisations that are transmitting immunisation notifications to the AIR are required to
transmit using a location (encounter place) provider number.

Note: Services Australia may require your organisation to register for an AIR provider number for
each encounter place where immunisations are recorded. Speak with Service Australia for further
information.

Note: If a location-specific provider number has not yet been applied for then, an individual doctor
who holds a valid Medicare provider number for the location can be defaulted to the encounter place
which will enable the transmissions of immunisations recorded in Communicare to the AIR while
waiting for your organisation’s location (encounter place) provider number to be issued.

*An encounter place is the building or address at which health care services are provided.
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55 Encounter Place with AIR Provider Number

To configure Communicare with the AIR provider number:

Select File > Reference Tables > Encounter Place.

( Encounter Place

O X

Description I

¥ Enabled

Address Line 1 ’

Address Line 2 [

Locality IF'erth

Phone [

Fax |

v| wA 6000

{* Service Encounter Place " Administrative Encounter Place

Belongs To

=]

Locality Group |
Record Storage v

=l

HIC Minor Location 1D |MDS00999

Establishment Code
DHF Health Service Code

Hospital Facility 1D
Location Code
Facility Code

Facility Type |Dthel Healthcare Services nec LI

HPI-0 Number |

SIwisl

AIR Provider No |

Default AR Provider |

=

¢g” Close I )‘\Cancell ﬂﬂslp ‘

Figure 1: Encounter Place - AIR Provider Number

1. AIR Provider No: record the location (encounter place) provider number associated with the
physical building/the location/the encounter place that immunisation notifications are
transmitted from to the AIR. This provider number is valid for the life of the building.

Note: When an AIR Provider No is recorded then a Default AIR Provider is not required to be

recorded.

2. Default AIR Provider: to be left blank.

Exception: if your organisation is awaiting a location (encounter place) provider number then
record an individual (person + encounter place) provider number who holds a valid Medicare
provider number for the encounter place at which immunisations are recorded. The individual
provider number will enable the transmissions of immunisation notifications to the AIR.

Note: Once your organisation has been issues from Service Australia the location (encounter
place) provider number then update the AIR provider No field with this number and delete the

name from the Default AIR provider field.
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5.5.1 Report Encounter Place with AIR Provider No and Default AIR Provider:

If you would like to report on all recorded AIR provider numbers in Communicare, speak with the
Communicare Support Service desk and ask to have the SQL Report Template ‘Reference Tables
Encounter Place (including AIR provider No and Default AIR Provider No)’ imported.

5.6 Healthcare Provider Identifier — Individual (HPI-I)

The HPI-1 is allocated to healthcare providers involved in providing patient care. A healthcare provider
will only be issued with one HPI-I, which will uniquely identify them. The HPI-I does not expire and
belongs to them as an individual.

e The HPI-I will identify the individual who recorded the immunisation clinical item.
o The AIR Provider Number identifies the encounter place/location that the immunisation was
recorded.

To record and verify a providers HPI-I in Communicare

Select File > Providers

Provider X

Logon User Name |E[_|_|3|3N|: LI Certain features are only available when providers are logged

on with this user name. See help for details.

( HEALTH

Prescriber Number

|1234567

|sm3 6165 BEE3 9462

Title o

Forenames |Chiistine Sutname |Ellison

Sex Female - Qualfications [MB

Registration Number |HCXD000000001 Speciality |General Medical Practiioner |

e er number is required in order to print prescriptions,
I3 Student [

Record Status: Verified

HPI- Mumber
Number Status: Active

Indigenous Status
Date OF Bitth

Enable Date

Motes

Verbal Order

Un-Scheduled [
s1— szl
SelT ST

I Claimant

I
I ]'

=

Cultural Awareness Training Given  ( Yes

LI Disable Date

" No ¢ Not Stated

Transport driver [
Show Medicare Claim Tab? v

| |

s3[ s4[  s5[
G1:] -

Encounter Places [ Select All

Exempt if Standing Order [

Eastern Branch Clinic
Malz'la Health Service
Millennium Health Service

Moithem Branch Clinic
St b B s Clinie

A

Encounter Place s

Provider Mumber

Effective Date

lxClamant | ~

| 3 E astem Branch Clinic 2121732 15/11/2004 I~
Mala’la Health Service |7
Millermium Health Service 2121734 15/11/2004 W
[N TR | R R . Rt Rat Bl L Ba al et Ty T Ll ~
Electronic Claims
Payee Provider - Delegated User [ADMINISTRATOR |

Sign the Claims using the PEl Token [

 Save | X Cancel | @ Help |

1. HPI-l Number: The Individual number assigned to the provider. To be entered manually.
2. Select this button to revalidate a previously entered HPI-I.
3. This button displays a history of HPI-I Numbers assigned to the provider.

For further information on HPI-I search the Communicare Help Menu for ‘HI Service’.
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5.7 Immunisation Datasets

Datasets are a user-friendly coding system, allowing health professionals a standardised way to
record and report on data entered in a patient’s clinical record.
Several different agencies supply standardised datasets.
There are two datasets in Communicare that relate to immunisations:
e Immunisation Age Based Reviews

e Immunisation Vaccines

571 Immunisation Vaccines

The Immunisation Vaccines dataset is a list of vaccines by brand name and includes the AIR export
codes. These are sourced from Services Australia:

https://www.servicesaustralia.gov.au/organisations/health-professionals/services/medicare/australian-
immunisation-register-health-professionals/resources/air-vaccine-code-formats#a

When this dataset is enabled, the vaccines can be recorded as structured data (clinical items and
qualifiers) within Communicare.

The vaccine clinical items are populated with the ‘AIR vaccine code’ in the clinical items export code
field. The export code is one of the components that will transmit the immunisation notification to the
AIR. Without the AIR export code, the immunisation will not be transmitted to the AIR.

For more information see 5.6 AIR export codes

5.7.2 Immunisation Age Based Reviews

The Immunisation Age Based Reviews dataset defines regular immunisation reviews based on age.

When this dataset is enabled the automated recall system will populate eligible patients’ clinical
records with recalls for:

¢ Review;immunisation;Birth

e Review;immunisation;2 month age
e Review;immunisation;4 month age
e Review;immunisation;6 month age
e Review;immunisation;12 month age
e Review;immunisation;18 month age
e Review;immunisation; 12 year age
e Review;immunisation; 4 year age

e Review;immunisation; 50 year age

If your organisation is reporting on the nKPI, NT AHKPI or NSW KPI for, ‘proportion of children who
are fully immunised’, the business rules of the reports are that the report will not look for evidence of
each and every immunisation required at specific ages, but rather will look for:

e Overdue recalls for age-based reviews
e Evidence of completed age-based reviews

© 2021 Telstra Health — Commercial in Confidence Communicare Australian Immunisation Register (AIR) Version1.2 Page 13 of 39
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o Absence of overdue recalls for any immunisation other than those known to be influenzas
vaccines.

Therefore, if your organisation is reporting on the nKPI, NT AHKPI or NSW KPI, this dataset must be
enabled. If your organisation would like to create locally maintained versions of these clinical items to
be able to add additional qualifiers, then ensure that the export code associated with each
review;immunisation<insert age> is included in the clinical item, as it is the export code that enables
the reporting outcome of fully immunised children.

For more information see the Communicare document ‘User Guide — Health Data Portal v.1.2’
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5.7.3 To configure Inmunisations Dataset

To configure the Immunisations Dataset:

Select File > System Parameters> System tab.

In the Datasets pane:

>
System | Clinicall Patientl Appuintmentsl Devicesl Electronic Claims | Secure Me&sagingl Web Servicesl HealthTracker

|H|:H:Iu|e Name | ~ - Startup Settings [~ Select all Event Summary
¥ Address Book Maintenance ¥ ‘ersion warning clinical data items by default
¥ Adverse Reaction Administration [# Offiine - Enable Discard Data [v Patient automatic search
[T Alerts and Other Information Contrel ¥ Patient phonetic search
¥ Appointments —Error Logging
¥ Biographics ™ Send Error Logs
[T Birth Notifications E_mail recipient(s):
[ Clinic Attendance - -

o communicareexceptionreport@health.telstra.com
[¥ Clinical Records
[¥ Clinical Reporting
[¥ Data Entry Wizard o Datasets
¥ Document Scanning These.areldatasets dlstrihut.ed by HealthConnex. Once a
) ] selection iz changed you will need te run the CENTRAL update program to
[¥ Electronic Claims effect the change.
[¥ Electronic Documents A Mo — e S
[+ EPDAddress Book Integration |Descrip1inn |Deﬁn'rtinn I .
[T Information Sharing Consent Maintenance [T | Awustralian Nurse-Family Partnership | The Nurse Famity Partnership
[" Information Sharing Consent Recording ¥ Communicare Infrastructure This dataset must not be dis...
F#  Intramail ¥ Communicare Value Added Clinical item types not yetin...
F¥ Investigations [T |Drug and Alcohol Treatment Service | Drug and Alcohol Treatment Si
[¥ Management Reporting [T Flinders Care Plan Flinders Model of Chronic Dise
¥ Medication View [T George Institute George Insitute Health Asse...
¥ Medications Management [T Headspace This dataset addresses Ver...
[ MeHR [ Heatthy Under 5 Kids The Healthy Under 5 Kids 2...
[T MeHR Administration [T 'Home and Community Care Wersion 2.01 (January, 2008).
[" MeHR e-Registration Auto-Prompt [T Home and Community Care (Victoria) | Wersion 2.0.1 (February, 2008
[ MeHR to My Health Record Transition v | ¥ IcPC2 Pus e ICRC-2 Plus dataset contain... | ,
FZ e Uankh Daaned A annon —
o Save I x Cancel | & Help |

Figure 2: Communicare System Parameters - Datasets

1. Set each dataset required.
2. Click Save
3. Ask Communicare Support Services to run the central update.
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5.8 AIR export codes

To be able to transmit immunisation notifications to the AIR, the immunisation must be recorded as a
clinical item and the clinical item will require an export code. The export code enables the
transmission of the immunisation notification to the AIR.

Communicare comes prepopulated with the majority of immunisations, however as new brands and
vaccines become available you may have to manually enter the immunisation with its associated
export code as a clinical item into Communicare.

& Immunisation:Fluarix Properties | X

General I Kepwords & Qua\iliersl Groups |
Record for occunence
" Date and Time

Formal Temms |Irm'nunisalim;FIualin [¥ Recallable

Natural Language |Immunisaliuﬂ;Fluullx

@ Date anly
Class Imnurisation x| Topc [Ressictoy =] [ Enabled [~ Serial Number Mandatory
Cost [ vVewngRght [Comen  v] e o
oExDult Code 'W Picture Fecord No. Iw
System Code li Letter Type [—;|
Itern Interval Ii Flule Cade ﬁ

Medicare Benefits Schedule

MBS Item No. Claim Interval

ICPC 2 Plus Component
Code Fidd Tem Status
SNOMED
Concept Id © Browse Status _|
Name

Definition of: | mmunisation;Fluarix

Always check annual seasonal influenza il ilability on the Immunisation Handbook website. Vaccines and age
eligibility change from year to year.

o Save x Cancel | Qﬂelp |

Figure 3: Immunisation clinical item with export code

1. Export Code: The AIR vaccine code that is used to send immunisation notification to the
AIR.

A list of the AIR vaccines codes can be found on the Services Australia website,
https://www.servicesaustralia.gov.au/organisations/health-professionals/services/medicare/australian-
immunisation-register-health-professionals/resources/air-vaccine-code-formats

For further information about creating an immunisation clinical item see 5.8 Immunisation Clinical
Item.
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The Immunisation Vaccine dataset is regularly updated as new immunisations are released into the
market. If a site regularly upgrades to the latest version of Communicare they will have the most up-
to-date Immunisation Vaccine dataset.

When new immunisations are released, details regarding the formatting of the immunisation will be

posted on the Communicare client portal.

If a site chooses to add an immunisation to the Communicare database themselves between

upgrades, then the format MUST be exactly as described below.

When your site upgrades Communicare with the updated version of the Immunisation Vaccine

dataset, the central import will disable the local term and add the central term as enabled. If the
format is not followed as instructed when creating immunisation clinical items in the local database
before the central immunisation’s vaccine dataset has been updated, then during upgrade there may
be potential impacts on reporting, as a duplicate clinical item will be created.

5.9.1 Immunisation Clinical Iltem Configuration

To configure an immunisation Clinical Item:

Select File > Reference Tables > Clinical Item types.

<

= T R S - S Locate:l
Dezcription |I:Iass.': |Topic.': |Defined.': |F|ecallab|e Enahled= |Eosl.’Z|F|ight.': Allo s
Ablation;endometrial | Procedure Female Ge... v v taternal & Sexual He...
Abnormal;appearan...  Condition Ene v Common
Abnormalblood ch... | Condition General & ... v Caomman
Abnarmal:breathing | Conditian Feszpiratary v Canrmar
[ Anomalzervials. [Condiion_JFemdee. || | | [MatemalSenalie. | i

>

o Close | &9 Help |

Figure 4: Clinical Item Type Maintenance

1. Select the green plus button.
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The General Tab

& New Item: Properties a X

General | Keywords & Qua\iﬁers] Groups |
Record for occunence

i
Formal Teims I [~ Recallable  Date and Time
Natural Language I e Date only
n Class Immunisation ~| Topic | ¥ Ensbled [~ Serial Number Mandatory
| Cost [ Vieving Right = AlowRecal Expiry
‘_‘Expoﬂ Code I Picture Record Mo. I 1790
System Code I Letter Type -
Item Interval I Rule Code

tedicare Benefits Schedule
MBS ltem Mo | I Claim Interval
& ICPC 2 Plus

Code Ii Temm Ii gf;:f;nm{

SNOMED
Concept Id Ii @ Browse Status _I
Name

Defintion of. New ltem

o Save | f\EanceIl Qﬂelp |

Clinical item type properties

Figure 5: New ltem: Properties - General tab with basic fields and with Advanced fields

1. On the General tab:

¢ In the Formal Terms field type: Immunisation;<insert immunisation>

o Use a capital letter ‘I' for immunisation.

e Do notinsert a space between the letters either side of the semi colon.

o When typing the immunisation type name, use a capital letter case for the
first letter directly after the semi colon.

For example: Immunisation;Adacel

¢ Natural Language: copy what was written in the formal terms into the natural

language field.

Class: select the class of ‘Immunisation’.

Cost: leave this field blank.

Topic: select the topic that aligns most closely with immunisation.

Viewing Rights: by default, select ‘Common’ unless there is a significant reason to

have a different viewing right.

Recallable: set to make the immunisation recallable.

Enabled: set by default.

e Allow Recall Expiry: leave unticked unless there is a significant reason have a recall
expiry for the immunisation.

¢ Record of occurrence: Select ‘Date only’.

e Serial Number Mandatory: leave unticked.
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2. Select Advanced to make additional fields visible:

o Export Code: enter the AIR export code.

e ICPC 2 Plus Code: enter the ICPC-2 PLUS code.

¢ Note: The ICPC-2 PLUS code can be inferred from other immunisations with the
same topic in Communicare or by researching the ICPC-2 PLUS website.

o SNOMED Concept ID: Enter the SNOMED concept ID by selecting Browse (optional)

e Definition of: if the immunisation requires a definition or instruction then this
information can be recorded in the ‘Definition of space provided.

e All other fields can be left as they are, no further configuration required.
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The Keywords and Qualifiers Tab

There are two types of keywords, one type is with a dollar sign in front of the word and the other is
without the dollar sign prefacing the word. $keywords display the linked clinical item in a shortcut list
in the clinical record. Keywords without a $ will search for clinical items in the Clinical Terms Browser

For example:

( HEALTH

‘ Clinical Record

BROWN. MARTIN EVAN 55¢is Male (07/10/1965) Patient ID 5384
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L
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we
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shionfs] 21 /07 /2004 Last Immunisation 0941172020
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E/ .Dime Monis, Millennium Health Service [4banginal Heakh Service) 13/01/2021 01:31 pm

Figure 6: Clinical Record - Immunisation shortcut button

1. $Ilmmunisation - any clinical items that are linked with this keyword will display in
‘Immunisation’ shortcut list in the clinical record.

Note: It is advised that the list of clinical items associated with the $Immunisation keyword is
reviewed and updated as required to display immunisations currently used at site.
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BROWN_. MARTIN EVAN 55prs Male (07/10/1365] Patient ID 5384
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Figure 7: Clinical Record - Clinical Terms Browser

2. Immunisation - any clinical items that are linked with the keyword ‘Immunisation’ will display
in the list of clinical item types when searching the clinical terms browser.
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To configure an immunisation Clinical ltem Keywords:

Select File > Reference Tables > Clinical Iltem types > Keywords & Qualifiers

i Immunisation; < Insert immunisation type>: Properties O x

General  Keywords & Qualiiers | Groups |

ds that can be u: P . ;
Wm(lmeﬂ . ‘.’w} Qualifiers Inked to: Immunisation; <Insert imewunisation lype>

& = Edt Keyword Table | | * Edit Qualfier Types
| |Keymword Order . |Qualfier  [Unit {Requred [Interval | Highlight Blank|Enabled|Min Age  |Max Age
> =[] r r r
_Immmm

>

| g Sme | Xcmee | @ neb

Figure 8:Clinical Item: Properties - Keywords & Qualifiers tab

1. Select the Green Plus to add keywords.
Note: If no keywords are selected, then the immunisation will not return on a search.
Repeat adding in any relevant keywords related to the immunisation.

2. If there are no existing keyword that accurately describes the immunisation then select
the ‘Edit Keywords Table’.
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Keyword Maintenance (Edit Keyword Table)

Times Used

$Calculatar
$Check up

°-< $Child health 12
$Enralment 4
$Examination 15
FlindersCT G 13
q $Group o |y

2 * = = Locate:

Clinical ltem Type 7
ANFPP A50 Result Fom Procedure
AMFPP AS0 SE Result Form Pracedure
AMFPP Client Change of Status Form Frocedure
AMNFPP Client Contact Form Procedure
AMFPP Client Feedback Survey Procedure
AMNFPP Demographic Details Form (Intake) Procedure
AMFPP Demographic Details Update Form Pracedure

W

o Save I }\Cancsl[ &) Help |

Figure 9: Keyword Maintenance

Two grids are displayed:

1. The upper grid lists existing keywords.

2. The lower grid lists the clinical items that are linked to the selected keyword (i.e the
keyword selected in the upper grid.)

To add a new keyword and a clinical item to the keyword:

3. Select the green plus button in the upper grid. A blank row will appear enter in the
keyword (keywords cannot contain any spaces or symbols).

4. Select the green plus button in the lower grid, the Clinical Terms Browser pop up will
appear. Find and select the clinical item to add to the keyword.
To add a clinical item to an existing keyword:
e Select the keyword in the upper grid.
e Click the green plus button in the lower grid to add clinical items to the selected

keyword.

5. Click Save

Note: Adding new keys words may not be required. Due diligence in checking before adding
new keyword to the existing keyword list to avoid duplication.
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510 Immunisation Influenza vaccines

Influenza vaccines are routinely added as new vaccines brands each year. Unless your site is using a
version of Communicare that has the vaccine as part of the Communicare central Immunisation
Vaccines dataset you can upgrade to the most recent version of Communicare or your local
Communicare administrator will be able to add the vaccines locally.

Vaccines not currently available in your local version of Communicare can be found on the
Communicare client portal.

If your organisation intends on running any of the nKPI, NT AHKPI or NSW KPI reports for influenza
immunisation coverage and your site has not upgraded to the version in which these reports have
been updated contact the Communicare Support Service Desk and request an update to the relevant
reports to recognise the new influenza export codes.

5.11 Immunisation COVID vaccines

Two new clinical items to record the administration of a COVID vaccination have been added to the
Communicare Immunisation Vaccines dataset.

¢ |Immunisation;COVID-19 Vaccine AstraZenec
e Immunisation;Pfizer Comirnaty

512 Immunisation Recalls

A recall is a clinical item that has a planned date but has not been actioned yet.
Recalls can be automated based on certain parameters or recalls can be manually entered.

Recalls are listed in the To Do list in the patients’ clinical record. When a provider selects the recall
that is due, they are presented with the clinical item and its associated qualifiers for completion.

5.12.1 Immunisation Age Based Review Recalls

If the Immunisation Age Based Reviews dataset is enabled, the automated recalls for each
Immunisation Age Based Review will be automatically enabled.

When this dataset is enabled the automated recall system will populate eligible patients’ clinical
records with recalls for:

¢ Review;immunisation;Birth

e Review;immunisation;2 month age

e Review;immunisation;4 month age

e Review;immunisation;6 month age

e Review;immunisation;12 month age

¢ Review;immunisation;18 month age

e Review;immunisation; 12 year age

e Review;immunisation; 4 year age

e Review;immunisation; 50 year age
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No further configuration is required on part of the Communicare administrator for recalls for this
dataset. For completing Immunisation Aged Based Reviews in the patient’s clinical record see 7.1
Immunisation Recalls - Clinical Record.
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5.12.2 Specified Immunisation Recalls

If your organisation would like to create locally configured recall protocols for specific immunisations,
there are several ways that these recalls can be generated.

Each method of generating recalls in a patient’s clinical record will incur different business rules.

o Automatically on registration of a patient

o Automatically on completion of a procedural clinical item

¢ Automatically on presentation of a condition clinical item

e Automatically in response to a qualifier

e Manually added by the user from within the patient’s clinical record

Automated recalls are created in Communicare under File > Reference Tables > Automated
Recalls.

512.3 Specified Immunisation Recalls - Influenza immunisation

Immunisation notifications that are transmitted to the AIR are based on the brand name of the
immunisation and not the generic name of the Immunisation.

Because the Influenza immunisation brand changes each year any automated recall protocol in place
for a specific brand of influenza will need to be updated annually.

To update the brand name of existing influenza vaccine recalls in patients’ clinical records, contact the
Communicare Support Service Desk requesting that the existing Immunisation;<influenza brand
name> recalls be updated to the current year Immunisation;<influenza brand name>

6 Patient Biographics

To successfully transmit immunisation notifications to the AIR, the following information is required
regarding the patient details:

e Patient name: alpha character, hyphens, apostrophes, numeric and spaces only. A hyphen
can be used however there cannot be a space between the hyphen and the characters. For
example:

o Martin-Adam Brown will successfully send.

o Martin — Adam Brown will not successfully send. (This is due to the spaces between
the hyphens)

o Martin- Adam Brown will not successfully send. (This is due to the spaces between
the hyphens)

¢ Patient: Date of birth

e Patient: Gender

e No PO Box number or ‘c/-' in line 1 or 2 of the home address field.

e Address: alpha character, hyphens, apostrophes, numeric and spaces only. A hyphen can be
used, however there cannot be a space between the hyphen and the characters.

e Alocality with a valid postcode number. (Locality name not to include state-based codes or
part of. Eg WA, SA, QLD, NT, ACT, VIC, TAS)

o Valid Medicare number (If known)

© 2021 Telstra Health — Commercial in Confidence Communicare Australian Immunisation Register (AIR) Version1.2 Page 26 of 39



7 Patient Clinical Record

Contained within a patient’s clinical record is a link to check the patient’s immunisation history with

AIR.

Adverse Reaction Summary m
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Alerts and Other Information !
[~ Atrisk if appointments are missed [ i Vom0 _T" Do
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1. Select the AIR button to view the AIR portal.

Note: If your system is configured to have multiple customised URL links, the AIR button is
replaced by a Go To button and the list of URL links appear in a popup menu.

7.1 Recording an Immunisation given

The Clinical Record Workflow for recording immunisation will detail the way in which immunisation

given and historical are to be recorded in Communicare.
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Immunisation given and historical
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Figure 10:Immunisation given and historical information
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Figure 11:Clinical ltem required qualifiers

1. Atleast one dose field is required to successfully send the immunisation notification to the
AIR:
e Dose (this course)
e Dose number

The following are not required to transmit the immunisation notification to the AIR, however,
should be recorded if details are known:

¢ Route and Site
e Tick on Performed at this encounter place
o If an immunisation is marked as Preformed Here, then Communicare will
transmit an AIR General Immunisation Claim.
o If animmunisation is NOT marked as Performed Here, then
Communicare will transmit an AIR-History Immunisation Claim.
e Vaccine batch
e Vaccine expiry date

Information as per the AIR online education resource:

Note: The AIR records vaccine doses at the antigen level, not the vaccine brand. This means that
vaccination providers need to notify the AIR of a dose number based on the number of previous
doses of the particular antigen that has been given. For example, if the DTP vaccine Infanrix Hexa
dose 1,2 and 3 are recorded on the AIR for an individual, and DTP vaccine Tripacel is given at 18
months, Tripacel should be recorded as dose 4, because it is the fourth of a DTP containing vaccine,
in this instance Tripacel should not be recorded as dose 1.

For further information see Service Australia,
https://www.servicesaustralia.gov.au/organisations/health-professionals/services/medicare/australian-
immunisation-register-health-professionals/resources/education-modules.

© 2021 Telstra Health — Commercial in Confidence Communicare Australian Immunisation Register (AIR) Version1.2 Page 29 of 39


https://www.servicesaustralia.gov.au/organisations/health-professionals/services/medicare/australian-immunisation-register-health-professionals/resources/education-modules
https://www.servicesaustralia.gov.au/organisations/health-professionals/services/medicare/australian-immunisation-register-health-professionals/resources/education-modules

( HEALTH

7.2 Recording historical Immunisations to Communicare

The Clinical Record Workflow for recording historical immunisation will detail the way in which
historical immunisations are to be recorded in Communicare, see Figure 10: Immunisation given and
historical information.

Historical immunisations can be recorded into Communicare from:

e The patient’s immunisation history already recorded on the AIR but not recorded in the
patient’'s Communicare file.

or

e Immunisations that are not recorded on the AIR that have been given elsewhere, such as
immunisations given overseas.

The automated transmission of immunisation notifications is a one-way transmission, meaning that
immunisations recorded in Communicare will automatically populate the AIR, however immunisations
recorded in the AIR will not automatically populate the patients Communicare clinical record.

Recorded immunisations from: = Recorded immunisations to: Transmission type
Communicare The AIR Automated transmission
The AIR Communicare Manual transcription

As an organisation you may wish to populate a patient's Communicare clinical record with historical
immunisation notifications from the AIR that are not currently recorded in the patients Communicare
clinical record.

If an immunisation is recorded in Communicare as historical information, then this immunisation will
be sent and recorded on the AIR database as a historical immunisation.

When recording an immunisation as historical information in Communicare do not tick the ‘performed
at this encounter place’ tick box.

Note on nKPI, NT AHKPI and NSW KPI Immunisation reporting: In the case of an immunisation
being recorded as being ‘given elsewhere’, then so long as Performed at this encounter place’ is not
ticked the denominator for the nKPI, NT AHKPI and NSW KPI immunisation reporting remains all
regular clients, regardless of whether the immunisation was provided at this encounter place or not
and will therefore be included in the KPI reporting.

Note: Any immunisation that is recorded in Communicare that was administered before 01/01/1996
will not be accepted on to the AIR.

7.3 Decline of an Immunisation

The Clinical Record Workflow for recording the decline of an immunisation will detail the way in which
the decline of an immunisation is to be recorded in Communicare.

If a patient declines an immunisation, the decline should be recorded by cancelling the recall with the
reason, ‘Declined by patient’ or ‘Declined by patient for all time’.

If there is no recall, add a recall for the specific immunisation that is being declined and then cancel
the recall with the reason, ‘Declined by patient’ or ‘Declined by patient for all time’.

National KPIs make no provision for patient’s decline so this will be recorded as a non-immunised
patient.
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Figure 12: Immunisation declined
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7.4 Editing or deleting an Immunisation record not yet transmitted to
the AIR

Until an immunisation is sent to the AIR at the defined time (5.3 Services.ini file), missing or invalid
data can be added or modified if required. If the transmission of the immunisation is not successful,
then data elements can be edited, and the transmission of the immunisation will be attempted to be
sent at the next scheduled feed to the AIR.

After a record has been successfully sent it cannot be modified.

7.5 Editing or deleting an Immunisation recorded incorrectly or in
error that has be successfully transmitted to the AIR

In the event that an immunisation has been recorded incorrectly or in error that has been successfully
transmitted to the AIR then you will need to:

1. Contact the AIR register and advise them of the error.

Contact Communicare Support Service desk and request that the flag is removed from the
immunisation in the patients’ clinical record. Because of the third-party integration between
Communicare and the AIR this process requires changes to the database and can only be
done by the Support Service desk after permission has been confirmed by the AIR.

3. Once the flag has been removed from the immunisation then the local Communicare
administrator will be able to edit or delete the immunisation. Edited records can then be
retransmitted to the AIR. For further support on how to edit or delete an immunisation from a
patient’s clinical record contact the Communicare Support Service Desk.

© 2021 Telstra Health — Commercial in Confidence Communicare Australian Immunisation Register (AIR) Version1.2 Page 32 of 39



( HEALTH

8 Online claiming window

Any immunisations with an export code recorded in patients’ clinical records will be listed in the Online
Claiming window. If the immunisation clinical item does not contain an export code, the immunisation
will not show in the online claiming window.

If an MBS item number has been associated with the immunisation service encounter, then the MBS
claim will be displayed in the Bulk Bill claims tab.

The AIR Claims tab displays immunisations statuses of transmission from Communicare to the AIR.

The Bulk Bill Claims tab displays MBS claims statuses of transmission from Communicare to
Medicare-Service Australia.

Communicare does not manage vaccination provider information payment. For further information see
the Services Australia website:

https://www.servicesaustralia.gov.au/organisations/health-professionals/services/medicare/australian-
immunisation-register-health-professionals/about/vaccination-provider-information-payments#a-1
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Figure 13:0nline Claiming Window — AIR Claims

Components of the AIR Claims Window:

Select File > Online Claiming.

1. Select the AIR Claims tab
2. Filter Settings
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a. Claim ID: When an AIR record has been transmitted there will be a claim ID
(transmission ID) associated with the submission. You can use the Claim ID field
to search for the immunisation associated with the transmission.

b. Show sent claim: By default the online claiming window will hide immunisations
that have been successful sent to the AIR. Ticking the Show sent claim box will
display all claims sent and pending.

c. Use Time limit: When selected will only show immunisations recorded in the last
6 months.

d. Encounter Place: When a specific Encounter Place has been selected then only
immunisations recorded at that Encounter Place will display.

e. Minor ID: The minor ID is an identification number that Medicare uses to
recognise the practice management software when transmitting online claims. A
practice may have 1 minor ID that identifies the organisation as a whole or as a
practice you may have multiple minor ID’s to further filter for individual or groups
of encounter places.

f.  Apply Filters: If any of the above filters a-e have been selected then to apply the
filters you must select the ‘Apply Filters’ button, otherwise the filters will not apply.

g. Reset Filters: If filters have been applied and you wish to clear the filters
previously selected then select the ‘Reset Filters’ button.

3. AIR Claims tool bar

a. Arrows: Can be used to navigate the rows of immunisations

b. Re-send to AIR: If an immunisation has not been successfully sent to AIR and it
has been sitting in the queue for a defined period of time (Apx.7 business working
days) then the Re-send to AIR text will change from light grey text to black text.
Once the Re-send to AIR is black in text then the button can be selected which
will Re-send the immunisation to AIR.

c. Get Reports: If there has been an error in downloading the Medicare Australia
reports to the Communicare database then this button can be selected to restart
the downloading process to get the Medicare report. The successful downloading
of the Medicare report will change the status of the immunisation from AIR Claim
waiting in queue to an outcome of error or sent. If the report has not downloaded,
then the status will remain as, ‘AIR Claim waiting in queue’. Reasons that this can
happen includes an invalid Medicare PKI certificate or there was not enough time
allocated in the services.ini command line to download the report. In the event
that there is not enough time allocated in the services.ini to download the report
then speak with the Communicare Support Service desk.

d. Encounter: Selecting this button will open the service record in which the
immunisation was recorded. The service record will show information such as the
claim type, encounter place and mode, provider, service start and end time,
Medicare claiming)

e. Biographic: The blue icon when selected will open the patient biographics. Use
this button to check that the required information to send to the AIR has been
recorded correctly. See 6 Patient Biographics
Note: In the patients biographic you will be able to view the Medicare claiming
history for the patient.

f. View progress notes for this service: Selecting this button will open the
progress note in which the immunisation was recorded.

g. Print the bulk bill assignment advice form: When selected will print the DB4
assignment form. The DB4 assignment form is what the patient signs to assign
the Medicare benefits to the provider of the service.

] -4 L2 L4l
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h. Edit admin note for the claim: The claim admin notes are used to record any
local claim administrator notes pertaining to the claim. For example, a claim
admin note could be, ‘Sent forms for Medicare card dd/mm/yy’.

i. Immunisation: When selected will display the immunisation clinical item and
associated qualifiers. Use this button to check that the required information to
send to the AIR has been recorded correctly.

4. Displayed List of Inmunisations
Columns displayed in the list are:

a. Claim ID: This 6 digit ID number is generated when the claim is transmitted from
Communicare to the AIR
b. Sent: This the date that the immunisation was transmitted from Communicare to
the AIR
Date Preformed: Date that the immunisation was performed.
Claiming Provider:
Patient Name:
Patient Family Name:
Age:
Immunisation Description: Immunisation name.
Status: Possible states for AIR claims:
o AIR Claim waiting in queue (no attempt to send record to the AIR yet)
o Error: AIR General Immunisation not sent
o Error: AIR History Immunisation not sent
o AIR General Immunisation Sent
o AIR History Immunisation Sent
j- Claim admin note: This is the display of the notes made by the claim’s
administrator.

—~Ta@ ™o a0

5. This will show the details about the transmitted AIR notification. To see the full report,
select the View Medicare Australia Report button.

8.1 Immunisation not transmitted from Communicare Online
Claiming window to the AIR

If an immunisation is not successfully transmitting from Communicare to the AIR the following
document can be used as a diagnostic guide to determine where the fail point is in the process for
transmitting immunisations to the AIR.

Note: Communicare will attempt to send any immunisation that has been added or modified in the
previous six months to the AIR and Communicare will continue to keep trying to send the
immunisation notification to the AIR until it either succeeds or 6 months elapse.

If the immunisation is not successfully sent to the AIR within the 6 month timeframe then the
immunisation will remain in the online claiming window as unsent. The AIR Online Claiming Window
can be filtered to Use Time limit: When selected immunisations recorded in the last 6 months will
only be displayed.
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AIR Online Claiming Window - Administrator

For an immunisation notification to successfully be transmitted to the AIR the following requirements
must be met. For further information see the Communicare Immunisations and the Australian
Immunisation Register (AIR) guide.

Does the patient biographics mest the following
requirements?

+ Patient name: Aphas, hyphens, apostrophes,
numeric and spaces orly.
Patient: Date of Birth
Patient: Gender
Mo Po Bos number or "o/~ in line 1 or 2 of the
home address field.
Address: Aphas, hyphens, apostrophes,
numeric and spaces orly.
Alocality with a valid postcode number.
(Locality name not to include stated based
codes or parts of eg WA, SA, QLD NT, NSW, Has a dose ara

Is @ provider number

ALCT, VIC, TAS) D th
o Are there immunisation « Valid Medicare number (if known) dose this CDL"S_E associated with the imn?::wsa.:on Are all required )
i=} yet to be sert in the N hyahens: Ayl be used D€e|.1 rer.ol.ﬂeﬂ_ in encounter place? either an clinical item have a |5_t’_"e PKI firewall Is the Medicare
ﬁ online claiming window hole onhyp! ::5 i :: can husha hmvew.: the _'mmr"f"“m" individual or location AIR expor code? certificate up exceptions report able to be
k7l AIR Claims? there cannot be a space between the hyphen an clinical iterm? based provider number, to date? openfwhitelisted? downloaded?
— the characters.
E — > > — > v = — Y > —Yes—
g ) | | | ; | |
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o
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£ Up_da.tr. pa_uem record the provider Cade. Contact the Support Service Support S_emce
E biographics Complete number. File > A 3 desk to discuss
=] [ isation;<i Reference Tables> Goto File = Feference Communicare desk to discuss configuration of
O mmUnISEton; <insert Table > Clinical ltem Support Service Desk apening/whitelisting. ‘guranon
lype given= Encounter Place - service.ini

ouauirier

Enter qualifier value

'Dose’ or 'Dose (this

course)' \ ]
pn A
-0
- |
oy
Mote: When ing qualifier i garding the ion given, at least one of these is required:

+ Dose {this course)
+ Dose number

The following are not required to transmit the immunisation to the AIR, however, should be recorded if details are known:
+ Route and site
+ Performed at <encounter place= * **
* Administered overseas
* Vaccine batch
« Serial number
« Vaccine expiry date

* |f the immunisation was performed at your health service then tick,
** |f the immunisation was performed elsewhere in Australia then leave unticked and the immunisation will be sent to the
AR as historical.

Figure 14: AIR Online Claiming Window - Administrator
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9 Immunisation Reporting

There are multiple reports available within Communicare to assist with immunisation reporting. Go to:
Reports > Search Reports and in the Search field search for ‘Immunisation’.
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10  Glossary

Glossary of terms covered in this document that you need to know.

( HEALTH

Term Function in Communicare

AIR export codes

The vaccine export code that enables the transmission of the
immunisation notification to the AIR.

Australian Immunisation
Register (AIR)

The national register that records all vaccines given to all people in
Australia.

AIR provider number
(individual)

An individual person who holds a valid Medicare provider number
for the location can be defaulted to the encounter place, which will
enable the transmissions of immunisations recorded in
Communicare to the AIR.

AIR provider number
(location)

A location provider number is associated with the physical building
that immunisation notifications are transmitted to the AIR from. This
provider number is valid for the life of the building.

HPI-|

Healthcare Provider Identifier-Individual. Uniquely identifies a
healthcare provider involved in providing patient care

Current patient

Is a patient who lives within the health service area locality group
and has had a client contact service within the patient inactivity
years.

Clinical Item A clinical item is a way of recording an event as structured data
within a patient’s clinical record. Examples of an event within a
patient's file could be an: Admission, Condition, Procedure,
Immunisation, Referral.

Datasets Datasets are a user-friendly coding system, allowing health

professionals a standardised way to record and report on data
entered in a patient’s clinical record.

Encounter Place

An encounter place is the place/clinic/building in which your health
service provides services at.

ICPC-2 PLUS

Enables the standardised way to record and report on procedures,
conditions, immunisations, referrals, history entered into a patient’s
clinical record.

Core terminology set used by Communicare.

ICPC-2 PLUS is a dataset

Locality

A Locality is used to identify where the patient lives. Their postcode.
Locality is a list of places used in patient addresses.

Medicare PKI Certificate

Digital certificate that enables transmission of Medicare claims
electronically to Services Australia.

Recall

A recall is a clinical item that has a planned date but has not been
actioned yet.
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11 Appendices

Third Party Certificates and Registration | 5.1 PKI Site Certificate
Requirement document

PS-CRWF14 - Immunisation given and 7.1 Recording an immunisation given

historical 7.2 Recording historical immunisations to Communicare
PS-CRWF15 - Immunisation Decline 7.3 Decline of an Immunisation

PS-CRWF16 - AIR Online Claiming 8.1 Immunisation not transmitted from Communicare to
Window - Administrator AIR
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